
Morpheus Photo Morpher™

Reviewer’s Guide
Morpheus Photo Morpher is easy-to-use picture morphing software 
that transforms one person or object into another before your eyes!

You've seen them on TV, in the movies, everywhere. Now you can create your very own Hollywood-style 
photo effects from your home computer. All you need is two digital pictures and Morpheus Photo Morpher. 
Amaze your friends and loved ones!

Included in the Reviewer’s Guide:

•  Screenshots
•  Tutorial
•  FAQ

Tutorial

Loading Pictures

Start Morpheus Photo Morpher by clicking on the icon, either on your 
desktop, or in the Start menu.
 
If you are in the right program, the corner of the screen should 
resemble this picture. 

Screenshots



The Layout Wizard can be seen when you first start Morpheus Photo 
Morpher. If it has been disabled, it can be selected from the File menu.

In this tutorial, we will create a simple photo morph. Select "Create a 
new photo morph layout" from the first page of the wizard and press 
the Next button to continue.

By default, the "Use beginner mode menus” option is checked. This 
hides all but the most basic features needed to familiarize yourself with 
the program. Turning this option off gives you access to normal mode, 
which includes all available features. 

The second page of the wizard is used to load the two pictures you 
wish to use in your morph. 

Click the Load Picture buttons above the picture preview boxes to 
select the picture file you want to load.

Select the picture file that you want to morph from for the box on the 
left, and the picture file that you want to morph to for the box on the 
right.  

In this example, the "dog.jpg" sample image (included with Morpheus 
Photo Morpher) will serve as the starting picture. Once the file is 
opened, it will appear in the picture preview box below the Load 
Picture button. Load the second picture using the button on the right. 
For this example, the "Alana.jpg" sample image will be used.

Once you have loaded your pictures, click the Next button. The final 
page of the wizard lists basic instructions for getting started. Once you 
click the Finish button, the wizard will still be shown in a smaller pane 
off to the side. 

Once you finish the Layout Wizard you will be brought into Morpheus 
Photo Morpher with a new layout containing pictures similar to what is 
shown here.

The label tabs above each picture window indicates which picture 
your morph will start with and which picture it will end with. 

Your morph is created by placing dots on the pictures. Select the Add 
Dots tool from the toolbar. 

Adding Dots

We’ll start by placing a dot near dog’s eye.  Placing dots around major 
picture elements such as the eyes, nose, or mouth yields the best 
results. Click on the picture to add a new dots. For every dot that you 
add to a picture, a corresponding "partner" dot will appear in the 
opposite picture window.  



Here we have added a dot near the other eye, and one on each side 
of the dog’s mouth. The more dots you use, the better the resulting 
morph.

The most recently added dot will glow with a colorful outline and its 
partner dot will glow with a black and white outline. The partner dots 
will appear in the same corresponding location of each picture. These 
dots will need to be adjusted so that they are situated on the same key 
elements of each picture.  

Select the Move Dots tool as shown here. This tool allows you to click 
and drag dots around the picture windows. 

We want to align the dots in both picture windows so that they are over 
corresponding elements. When you hover over a dot, it glows with a 
colorful outline and its partner dot glows with a black and white outline.

Click on the dot, drag it to a new location, and release the mouse 
button.  

Aligning Partner Dots

Previewing the Morph

Here we have moved the red dot over the girl's right eye, since that 
dot's partner dot is located over the dog's eye in the other picture 
window. 

 Move the other three dots in the same fashion as the first one. 

You can see how we aligned all of the dots near the same picture 
elements as their partner dots. 

The Preview window is located on the right side of the screen by 
default. It can be hidden and shown by pressing Ctrl+P. 

The Preview window shows one frame of your animation at a time. 
You can view different frames of your animation by dragging the track 
bar left and right. 



The easiest way to quickly see your morph in action is to play your 
animation in real time right inside of the Preview window.

To see the Preview window play this morph, visit this link and scroll 
down to the bottom of the page:

http://www.morpheussoftware.net/morpheusmorph/tutorial/morph4.php

When you view the animation, you can see how well the eyes and 
mouth line up using only four dots. Notice, however, that other key 
features, such as the ears and neck, are blurred. This is because there 
are no dots on those features. Adding only a few more dots to these 
areas will 
dramatically improve your morph.

The button to the left of the Render Timeline button is the Save Layout button. Saving your layout creates a file 
that can later be modified in Morpheus Photo Morpher. Rendering creates a file which can be emailed or 
displayed in other programs, but which cannot be changed by Morpheus Photo Morpher in the future.  

Rendering the Morph

 Here we have added a total of 35 dots to the morph and are ready to 
render it to a file for use outside of Morpheus Photo Morpher. 

This layout in its final form is available as one of the sample layouts 
included with Morpheus Photo Morpher. 

To render your morph, press the Render Timeline button on the 
toolbar, as shown here. 

In the Save As window you can select a location to render your morph 
to, enter a name for the file, and select a file type to render to. Enter 
any file name you wish, but make sure you remember which folder on 
your hard drive you saved your morph into. 

Flash SWF and Animated GIF formats are the best for displaying on 
webpages. Here we will select SWF from the drop-down menu. 

After a brief rendering progress window, your morph file will be created 
and ready for viewing.  

To see it in action, visit this link and scroll down the page:

http://www.morpheussoftware.net/morpheusmorph/tutorial/morph5.php 



For this example, we are starting with a different morph, as pictured here. This layout is also among the samples 
included with Morpheus Photo Morpher. 

The quickest way to add a key frame is to enable Preview All Frames in the Timeline window. Simply click on 
any of the frame thumbnail buttons to select it, then press the Make Key Frame button. A keyframe will be 
made at that point in the morph. 

(Pro) Using Key Frames

Key frames are an optional step that you can use to 
improve the look of your morph. 

This is a more advanced feature which requires 
Morpheus Photo Morpher Professional, as well as 
having beginner mode menus unchecked.  

Key frames define midpoints in your morph to allow the 
dots to move in a defined path as they transition from 
the starting picture to the ending picture. 

Normally, the dots would move in a straight line from 
their position on the starting picture to their final 
position. 

Key frames are defined at certain percentage points in 
the morph and are not tied to specific frames in the 
timeline. 

This example key frame was created at the 50% point 
in the morph.

Simply double click on the keyframe button in the 
Timeline window and a new window will appear, 
allowing you to adjust the dots for that key frame.  

The key frame windows work just like the 
picture windows. The dots have multiple partner 
dots instead of just one partner dot now. 

The number of partner dots each dot has will be one 
more than the number of key frames in that morph. 



When you move the dots in the key frame window, the picture will 
be updated to show you what the morph will look like at that 
percentage point.
 
The morph will transition from the starting picture to this key frame 
before completing the transition to the ending picture. 

1. What is Morpheus Photo Morpher?
Morpheus Photo Morpher is an award-winning graphics program that lets you create animations of photos or 
movies morphing from one to another. Morpheus Photo Morpher v3.00 lets you create morphs in Flash SWF, 
Animated GIF, AVI, JPEG, PNG, TIFF, and other popular formats. It is easy, fast, and fun to use for both begin-
ning and advanced users.

FAQ

2. What are beginner mode menus?
By default, Morpheus Photo Morpher will use beginner mode menus, which will hide all but the bare essential 
menu choices needed to create a simple morph. For most users, we suggest starting out by leaving the program 
in beginner mode and moving up to normal mode once you are comfortable with the program. 
You can use the normal mode menus by unchecking the beginner mode menus checkbox from the layout 
wizard. You can also set this option from the Edit menu. Normal mode will show all available menu options.

3. Why are some of my dots the same color?
In beginner mode, you are fixed with a cycle of 8 basic dot colors. You will inevitably have several dots that are 
the same color. To tell the dots apart and to correctly locate their partner dot, highlight one with your mouse. 
Its partner dot will highlight as well. You can change the color, style, and dot size by selecting Customize Dot's 
Default from the Morph menu.

4. What is the best way to view my morph when I am finished?
When you have finished creating your photo morph you can view it for yourself right inside the program in the 
preview window.  You can render your photo morph to many picture formats such as JPEG, PNG, or TIFF which 
can be viewed in a variety of applications. 

5. What formats can I render my morphs in? Which is the best?
Movie Files: These formats save the entire morph as a single animated file. 

•  Compressed AVI: Use any installed Windows DirectShow or Video for Windows Codec to compress your
   movies for smaller files.
•  Uncompressed AVI: Perfect quality movie, very large, good for importing into movie editing software such as
   Adobe Premiere.
•  Flash SWF: Best for display on webpages, very small and high quality, and supports full translucency.
•  Animated GIF: Good for webpages, every browser can view them, but images are only 256 color, and thus
   limited to lower quality.



Picture Sequences: These formats save each frame of the morph as an individual file. 

•  PNG: Perfect quality images, small file size, and supports full translucency.
•  JPEG: Very small files good for webpages, but quality poor at higher compression settings.
•  TIFF: Perfect quality images, large like bitmaps.
•  BMP: Perfect quality shot of every frame, but very large files.
•  TGA: Perfect quality, large, but supports translucency in more programs.
•  XPM: Larger than all other formats, but useful for importing to Linux systems.

Which file type is the best depends on what you want to do with your photo mix. If you are unsure, you can try 
each of the formats and see how they work with the other programs.

6. What do I do with my completed morphs?
Use your morphs to grab people's attention or to have a good time.  Create web graphics and enhance your 
web site, email morphs to friends and family to make them laugh, create a unique online greeting, post your 
morphs on the Internet, add more life to your presentations, or use your morphs in countless other great ways!
 
If your morph is unique and exciting, and you want to share it with other Morpheus Photo Morpher users, you 
might consider submitting it to us for display. 
 

7. How can I email my morph to a friend?
You can email your animations using the built-in email feature by selecting "Email your morph to a friend" from 
the Share menu in the program. The Send Morph Wizard will appear, allowing you to fill in your From address 
and any number of recipient addresses. On the last page of the wizard, press the Send button and your email 
will start sending. Please be patient as it sends as large animations may take longer to send.
 
You can also render the timeline to a file of any type and attach that file to an email in your regular email 
program just like you would any other file. It is recommended that you render a file type that is small in size, 
such as JPEG or an AVI compressed with an MPEG-4 codec such as DivX or XviD. 

8. How do I turn one person into another?
Creating an animation of one person transitioning into another is called a morph, and morphing is exactly what 
Morpheus Photo Morpher is designed to do. Please see the tutorial for step-by-step directions on creating morphs. 

9. How do I distort a picture of somebody?
Creating an animation which distorts a picture of a person is called a warp, but this is not the focus of 
Morpheus Photo Morpher. In order to create warps, you would need the functionality of Morpheus Photo 
Warper or Morpheus Photo Animation Suite. 

10. How do I put somebody's head on somebody else's body?
Creating a picture which uses features from two different pictures mixed together is called a photo mix, but this 
is not the focus of Morpheus Photo Morpher. In order to create photo mixes, you would need the functionality 
of Morpheus Photo Mixer or Morpheus Photo Animation Suite. 

11. Can I morph more than two pictures?
Yes, you can easily morph more than two pictures. The layout wizard which appears when you start Morpheus 
Photo Morpher can guide you through loading as many pictures as you want and have them morph from one 
to another in the order you choose.

To add additional pictures to an existing morph, select "Add morph" in the Timeline window. Double click on the 
morph buttons in the Timeline window to open any two picture windows side by side. You can then use the 
"Load Picture" button to load a new picture or change the existing picture for any picture window. 



12. Why do my pictures look squished in the Preview window?
Morpheus Photo Morpher automatically sizes your timeline based on the sizes of the pictures you load. If you 
load two pictures with different aspect ratios, or manually set a different size for your timeline, then some 
pictures may look squished in the Preview window. Morpheus Photo Morpher will stretch all pictures to fill the 
timeline size. As a result, they may appear squished vertically or horizontally in order to fit.

It is recommended to use pictures of similar aspect ratios by cropping them to the portions you want. You can 
use the Picture Layout option to change how the picture appears in the morph area. This will allow you to 
adjust the aspect ratio and stretching of the pictures as well as effectively crop parts of the pictures to be 
unused. 

13. What are the best size pictures to use?
It is recommended to use pictures of the largest dimensions you can, since you can easily zoom in and out to 
place dots at precise locations better when there are more details with which to zoom. Keep in mind the aspect 
ratio of your pictures though. If, for example, one picture is 1000x1000 pixels, but another is 1000x800 pixels, 
then the second picture may look stretched in order to match the aspect ratio used by the entire timeline. 
Larger picture dimensions also allow for more clarity when parts of your morph are stretched larger. 
 

14. Can I add dots to just one picture individually?
Every dot you add to one picture will automatically get a corresponding partner dot on the opposite picture. 
Dots only come in pairs, because the purpose of a dot is to match up key features in each picture to tell Mor-
pheus Photo Morpher how the starting picture will morph into the ending picture. 
 

15. I closed the picture windows. How do I get them back?
In the Timeline window, simply doubleclick on any of the picture thumbnail buttons to open that picture window 
so that you can adjust the dots on it. The morph buttons just above the picture buttons will open both pictures 
for that morph side by side when double clicked.
 
If you do not see the Timeline window, it may be hidden. Select Timeline from the View menu to toggle 
showing and hiding the Timeline window.

16. What is the difference between a morph, a warp, and a photo mix?
A morph is an animation of one person transitioning into another. A warp is an animation where one picture is 
stretched or distorted. A photo mix is a still picture which is created using parts taken from two other pictures.
 
Morpheus Photo Morpher is used to create morphs. In order to create warps, you would need the functionality 
of Morpheus Photo Warper or Morpheus Photo Animation Suite. In order to create photo mixes, you would 
need the functionality of Morpheus Photo Mixer or Morpheus Photo Animation Suite. 

 17. How can I use my rendered animated GIF files in PowerPoint?
You can insert your animated GIF files into PowerPoint by selecting Insert / Picture / From File from the menu 
in PowerPoint, just like you would place any other picture file in your slideshow. Currently, no version of Power-
Point properly plays all animated GIFs like your web browser does. This is not a defect of Morpheus Photo 
Morpher or the animated GIFs it creates, but simply that PowerPoint does not properly obey the looping 
information stored in any GIF file. What's worse is that PowerPoint from each version of Microsoft Office 
behaves differently: 

 



•  Office 2000 - All animated GIF files will loop forever. There is no way to stop the animation at the end. 
•  Office XP - Animated GIF files which should loop forever will act as they should. For files which are set to
   play a certain number of times, PowerPoint plays the GIF one less time than it should. For files which are set
   to play just once, PowerPoint will play them once and stop as it should. 
•  Office 2003 - Plays animated GIF files similar to Office XP, except that files which are set to play just once
   won't play at all. They will instead remain on the first frame of the animated, paused forever.

If you would like your animated GIF files to play once and stop at the end, the safest way seems to be to set them 
to be played twice in Morpheus Photo Morpher and make sure that you view the slideshow in PowerPoint using 
Office XP or higher. However, it is possible that the next version of Office, after Office 2003, will start playing 
these files correctly, and the same slideshow would thus repeat the animation twice in the future.
 
Another thing you may want to do in PowerPoint is have your animation showing the first picture, and have a click 
begin the animation. This can most easily be accomplished by creating two similar slides, where the first slide 
actually uses a still picture, and the next slide has the animated GIF in the same location. If all other text in the 
two slides is the same, the click between the two slides will give the appearance of starting the animation. 

18. What is a codec and which one should I use?
A codec is a "Compressor / Decompressor" and it is what is used to compress AVI files in order to make them 
smaller. Nearly all AVI files are compressed with some codec, but they do not always use the same codec. In 
order to play back an AVI, you must have the codec installed which was used to compress it, or you will be 
unable to decompress it for viewing.
 
Morpheus Photo Morpher allows you to compress AVI files with any codec installed on your system, as well as 
set the various configuration parameters these codecs use. Some codecs are much better than others and the 
better ones can not only result in higher quality videos, but smaller files as well. The latest generation of MPEG-4 
codecs such as DivX and XviD are recommended because they have one of the best combinations of small file 
size and high quality video. You can use any codec you like, but keep in mind that anybody who needs to view 
the AVI you create would need to have that same codec installed, and not many high quality codecs come 
pre-installed with Windows. 

 

 20. How can I make my animation play only once instead of repeating forever?
In the Timeline Options window, you can set the "Loop morph" to "Stop after the first time" instead of the default 
of "Loop forever." This will work for Flash SWF as well as animated GIF files. If you render your morph to an AVI 
file, this option has no effect because the AVI file format does not have any way to specify the number of times 
the file should loop. It is up to the program you are viewing the AVI in, such as Windows Media Player, to loop the 
movie or not.
 
In newer versions of Windows Media Player such as 9 or 10, you can simply select Repeat from the Play menu to 
toggle on and off looping the movie file or playing it only once. In Windows Media Player 6.4 there are playback 
options under View / Options where you can adjust the number of times a movie file should loop. 

 19. How can I make my animation wait at the beginning or the ending longer?
Each morph in your timeline can be set to hold for any duration for the starting and ending pictures. Simply select 
Morph Options from the Morph menu and enter any number of seconds in either "Time to hold for at start" or 
"Time to hold for at end". You can also set your animation to stay on the last picture forever by setting the "Loop 
morph" setting in the Timeline Options to "Stop after the first time."



21. Why does my AVI file go back to the starting picture after the animation plays?
An AVI file has no way to specify what should happen when the movie is finished inside the file itself, so it is up to 
the program you are viewing the AVI with whether or not it should rewind the movie when it is finished playing. In 
new versions of Windows Media Player such as 9 or 10, there is no way to change the default behavior. If the 
Repeat option is off, Windows Media Player will play the movie through once, then automatically rewind it back to 
the first frame and stop. In Windows Media Player 6.4, you can adjust the rewind option by selecting Options 
from the View menu and checking the "Rewind when done playing" option.

22. How can I keep transparency in my rendered files?
Morpheus Photo Morpher by default only renders 24bit truecolor images for each frame, but if you check the 
"Morph the alpha channel" option in the Timeline Options window, then a 32bit image with alpha channel will be 
rendered for each frame. If you wish to keep the entire alpha channel information in tact, you should set the 
"Transparent threshold" to 0.
 
The best format for keeping the entire alpha channel in is to render to Flash SWF, which can be set in a web 
page and blend properly using the alpha channel. For animated GIF files, it is recommended to set "Transparent 
threshold" to 128 so that any pixel which is less than 50% transparent will become the single transparent color 
index in the GIF file. If rendering to a series of still images, PNG is the best format for keeping the alpha channel 
in tact, and with the proper web page, it can be shown in all major web browsers and blended properly with the 
background.

Uncompressed AVI files will store the alpha channel information in the file, and some codecs for compressed 
AVIs may as well, but most AVI viewers will not use this information. If you are using a movie editing program and 
importing the AVIs for further processing, the alpha channel information may be useful depending on which 
movie editing program you are using. 

23. What happened to the dot delay option?
Morpheus v1.85 featured a dot delay option which controlled the time a dot would start and stop moving and 
fading, where the dot would stand still entirely faded towards one picture before and after the set times. 
In Morpheus Photo Morpher v3.00, this is replaced by a much more powerful combination of key frames and fade 
graphs. Dot delay saved in layout files from Morpheus v1.85 will be imported and converted to the new features 
automatically.

To define a time period where dots don't move, you simply need to add one key frame to the timeline. Then copy 
and paste the dot locations from the picture window to the key frame window, so each dot is in the same location. 
The fade graphs can then adjust the dots on each key frame to fade between the pictures with any given amount, 
not just 0% or 100%.


